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Welcome



Welcome to the March issue of the Microsoft K-12 Technology Connection, a newsletter published on this Web site and delivered via e-mail to the desktops of subscribers. We hope to make this newsletter a forum for technology decision makers to share their experiences building connected learning communities in their schools or districts. This will also be the place to get overview as well as tip and troubleshooting information on products such as Microsoft( Windows NT( Server operating system, Internet Explorer, and Office 97.



This month in the Connected Learning Community section, we continue our series profiling Blackstock Junior High in southern California. In this article, Steve Carr, site technology coordinator at Blackstock, describes how he’s made the desktops in his school tamper-proof using Policy Editor and User Profiles within both the Microsoft( Windows NT( and Windows( 95 operating systems.



In the Internet/Intranet section, you can read an interview with Katie Jordan, an Education Product Manger at Microsoft, who gives an inside view of the Microsoft Office family of products being used in education.



In Networking, we offer a look at a New Hampshire school that switched from Novell NetWare to Windows NT. In a second article, Bob Kelly, a Product Manager for Windows NT Operating Systems, compares the basic design of Windows NT to IntranetWare with an eye to building an intranet. 



In  On Your Desktop,  you can read about a high school district in the Sierra Foothills of northern California that uses the principles of applied education to integrate technology into the curriculum.



Finally, visit Classroom Corner if you’re looking for foolproof and fast ways to create Web pages using Microsoft FrontPage( 97 and Publisher 97.



Your comments and suggestions are welcome. To contact us, please click E-mail Us at the bottom of the newsletter home page at http://www.microsoft.com/K12/News/.



( 1997. Microsoft Corporation. All rights reserved.



1. Connected Learning Community

Setting Boundaries

A combination of system tools and user policies are the key to creating a tamper-proof computing environment that doesn’t restrict learning.  



By Jeff Zwier 



It’s  10:00 AM in your classroom.  Do you know where your students are in cyberspace? 



Prior to the introduction of computing technology into the classroom, a teacher’s primary focus was to deliver information and create an environment that facilitated learning.  That charter remains, but with the introduction of technology, educators are faced with a new set of challenges. Teachers now need to facilitate learning through multimedia and networked computing technologies. Computers act as hi-tech “windows,” opening the classroom to the world, where it becomes the first building block in a connected learning community that embraces students, educators, parents, and the extended community in dynamic, continuous interaction. 



But that openess is a two-way street, and with any open environment come risks(from inside and out. In this, the third article in a series focusing on Blackstock Junior High in Oxnard, California, Steve Carr, site technology coordinator at Blackstock, shares some of his insights into creating a secure computing environment using tools and policies in Microsoft( Windows( NT that don’t place restrictions on learning. Carr’s district has only recently been networked and Carr himself is currently in the middle of creating a school intranet(so most of his security issues involve preventing students from tampering with desktop operating systems in the classroom. However, he also describes a few measures he’s taken to cope with risks from external sources.



Opportunity and Flexibility 

Today’s software is designed to be flexible, open, and provide users with the freedom to choose a variety of ways to get things done, from system configuration to word processing.  That very flexibility and openness, designed with large businesses and adult home users  in mind, creates unique challenges for those working with students.  “In education, the paradigm is a little different,” says Carr.  “One of the things that has traditionally been a problem with open systems has been that kids like to start changing things.” In other words, kids will be kids(curious and eager to explore a new environment.  “Our challenge is to give the ease of use to kids but also to avoid having students move things around.  The way we’ve solved that problem is we’ve taken advantage of the Policy Editor and User Profiles within both Windows NT and Windows 95.”  Giving students access to a robust computing environment while setting limits on appropriate behavior, Steve explains, is largely a matter of setting policies within both the network and school environment. 

System Policies 

Unlike corporate environments, schools frequently have many different students accessing the same computers every day.  As a result, a number of curious minds can find unique ways to configure desktops, start or stop applications, enter restricted areas or make mysterious (but necessary) system files disappear.  



Creating policies for student users through the Windows NT Policy Editor can help you steer students toward the right resources without the need for extensive levels of password security.  In fact, a small group of logons and user profiles can serve a wide range of users, from students to network administrators.  Carr has established a limited set of standard user profiles for the students and staff at Blackstock.  “What we do, essentially, is create generic users on the [Windows NT] server and enable the client side to log on to our domain,” says Carr.  “Once they log on, a profile [including settings for desktops, available programs, printers and controls] is dictated to them.  We lock things down pretty tightly, depending on the environment that kids are in.”  Students and teachers have a wide range of access: for example, Carr has full administration rights to the network while students have basic access to video, word processing, and the Internet. 



Examples of the restrictions that can be controlled by the Policy Editor include desktop properties, Start menu options, enabling or disabling, and establishing and sharing custom folders for individual students to store their work. The Policy Editor also can be used to restrict access to everything on the desktop from the My Computer icon to some or all of your school’s Network Neighborhood.



The explosion of educational resources on the World Wide Web has created a new set of network security concerns. While the standard Windows NT Server package does not specifically address Web site filtering, access to the Internet can be controlled via the security features of Internet Explorer 3.0* or third party products such as Solid Oak Software’s CyberSitter.  “CyberSitter has been really effective for us.  Typically, we will download the filter file [controlling what a student can see on the Internet], store it on a mapped network drive, and point to the mapped drive on each client.  The software both blocks and reports site visits and attempts and incorporates seamlessly with the administration tools in Windows 95 and Windows NT.”



As Blackstock’s network content grows, external security issues become more and more important.  The temptation to “hack” academic Web sites is strong(particularly among former students.  Carr currently employs an NFC router to screen unauthorized IP addresses. This hardware, along with proxy servers, firewalls and other advanced security tools, may become part of the overall security strategy for the school as its Web content and intranet grows.



Despite some of the interesting things that students have done over the years with the schools’ systems( from printing files in remote locations to starting applications in other classrooms(Carr points out the need to keep your perspective when establishing user restrictions.  “Kids aren’t necessarily doing it [changing settings, visiting inappropriate Web sites, and so on] because they are malicious, they’re doing it because they are curious.”

People Policies 

Carr strongly emphasizes that maintaining a secure computing environment and effectively using technology in education go far beyond system tools.  “We can do as much as we can on the software side, either by network administration or by blocking Internet sites, but prior to that the most important thing is to have kids understand why they have access to technology.” At Blackstock, students, teachers, and parents sign Acceptable Use Policies that outline the benefits(and responsibilities(of using computers in the classroom. Explaining the reasons why computers are available at school and the ethics and etiquette of responsible computer use build a solid foundation for learning and reduces behavior and security problems down the road.



In the end, teachers and students together hold the key responsibility for effective security and learning, both in maintaining password security for their own user privileges and ensuring that classroom technology is used effectively.  “The teacher is are really the one who has to direct and facilitate what kids do in the classroom.  If [they] can build a level of responsibility into kids from the very beginning, you will avoid a lot of problems later on with discipline problems or would-be ‘hackers’.”  Building and maintaining strong relationships between teacher, student, school technology administrators, and parents about the goals and responsibilities of computer use in the classroom lead to the highest levels of network stability and security in the long term.



* For information on how to use the security features of Internet Explorer 3.0, see the Internet tip in the January issue of this newsletter.



About the author: Jeff Zwier is a technology services consultant with expertise in technical training, recruiting and Windows NT networking.  He is currently a consultant with Interim Technology’s Technical Communications and Training Practice in Oak Brook, Illinois. You can reach him at jzwier@msn.com. 



Heuneme Acceptable Use Policy and Related Forms



Electronic information services are available to students, teachers and staff in our district who qualify. Our goal in providing this service is to promote educational excellence by resource sharing, innovation, and communication. The Hueneme School District will make every effort to protect students and teachers from any misuses or abuses of the information service. All users must be continuously on guard to avoid inappropriate and illegal interaction with the information service.



Every classroom in the eleven schools in the Hueneme School District has been cabled with Category 5 cable to receive Internet and network services.  At the present time each school is in a different stage of implementation.  Each school has a router enabling them to communicate on the Wide Area Network (WAN).  Within each school network there are switches which  allow all classrooms within the school site to communicate with each other.



Four things have been put in place to protect electronic users in the Hueneme School District.  They include:

Signing an Electronic Information Resource Contract prior to using any equipment.

Using fire walls within the Hueneme School District system to protect information.

Installing software packages such as Cybersitter (electronic babysitters) to block out the use of inappropriate sites and material.

Teacher supervision whenever students are accessing electronic information.



See the following documents:

District-User Electronic Information Resource Contract

School/Student-User Electronic Information Resource Contract

Permission Slip for World Wide Web Home Page

DISTRICT-USER ELECTRONIC INFORMATION RESOURCE CONTRACT

Electronic information services are available to students, teachers, and staff in our district who qualify.  Our goal in providing this service is to promote educational excellence by resource sharing, innovation, and communication.  The Hueneme School District will make every effort to protect students and teachers from any misuses or abuses of the information service.  All users must be continuously on guard to avoid inappropriate and illegal interaction with the information service.



Please read this document carefully.  When signed by you, it becomes a legally binding contract. Listed below are the provisions of this contract.  If any user violates these provisions, access to the information service may be denied and you may be subject to disciplinary action.

TERMS AND CONDITIONS OF THIS CONTRACT



1. PERSONAL RESPONSIBILITY.  I will accept personal responsibility for reporting any misuse of the network to the system administrator.  Misuse can come in many forms, but it is commonly viewed as any messages sent or received that indicate or suggest pornography, unethical or illegal solicitation, racism, sexism, inappropriate language, and other issues described below.

2. ACCEPTABLE USE.  The use of my assigned account must be in support of education and research and with the educational goals and objectives of the Hueneme School District.  I am personally responsible for this provision at all times when using the electronic information service.

a. Use of other organizations’ networks or computing resources must comply with rules appropriate to that network.

b. Transmission of any material in violation of any United States or other state organizations is prohibited.  This includes, but is not limited to: copyrighted material, threatening or obscene material, or material protected by trade secret.

c. Use of commercial activities by for-profit institutions is generally not acceptable.

d. Use of product advertisement or political lobbying is also prohibited.

3. PRIVILEGES.  The use of the information system is a privilege, not a right, and inappropriate use will result in a cancellation of those privileges.  Each person who receives an account will participate in a discussion with a Hueneme School District faculty member as to proper behavior and use of the network.  The Hueneme School District system administrator(s) will decide what is appropriate use and their decision is final.  The system administrator(s) may close an account at any time if necessary.  The administrator, staff, or faculty of Hueneme School District may request that the system administrator deny, revoke, or suspend specific user accounts.

4. NETWORK ETIQUETTE.  You are expected to abide by the generally accepted rules of network etiquette.  These rules include, but are not limited to, the following:

a. BE POLITE.  Never send, or encourage others to send, abusive messages.

b. USE APPROPRIATE LANGUAGE.  Remember that you are a representative of our school and district on a non-private system.  You may be alone with your computer, but what you say and do can be viewed globally!  Never swear, use vulgarities, or any other inappropriate language.  Illegal activities of any kind are strictly forbidden.

�c. PRIVACY.  Do not reveal your home address or personal phone numbers of students or colleagues.

d. ELECTRONIC MAIL.  Electronic mail (e-mail) is not guaranteed to be private.  Everyone on the system has access to all mail.  Messages relating to or in support of illegal activities must be reported to the authorities.

e. DISRUPTIONS.  Do not use the network in any way that would disrupt use of the network by others.

f. OTHER CONSIDERATIONS:

-	Do be brief. Fewer people will bother to read a long message.

-	Do minimize spelling errors and make sure your message is easy to understand and read.

-	Do use accurate and descriptive titles for your articles.  Tell people what it is about before they 	read it.

-	Do get the most appropriate audience for your message, not the widest.

-	Do remember that humor and satire is often misinterpreted.

-	Do remember that if you post to multiple groups, specify all groups in a single message.

-	Do cite references for any facts you present.

-	Do forgive the spelling and grammar errors of others.

-	Do keep signatures brief.

-	Don’t “attack” correspondents; persuade them with facts.

-	Don’t post to a group you don’t know.

5. SERVICES.  The Hueneme School District makes no warranties of any kind, whether expressed or implied, for the service it is providing.  The District will not be responsible for any damages you suffer while on this system.  These damages include loss of data as a result of delays, non-deliveries, mis-deliveries, or service interruptions caused by the system or your errors or omissions.  Use of any information obtained via the information system is at your own risk.  The District specifically denies any responsibility for the accuracy of information obtained through its services.

6. SECURITY.  Security on any computer system is a high priority because there are so many users.  If you identify a security problem, notify the system administrator at once.  Never demonstrate the problem to other users.  Never use another individual’s account.  Any user identified as a security risk will be denied access to the information system.

7. VANDALISM.  Vandalism is defined as any malicious attempt to harm or destroy data of another user or any other agencies or networks that are connected to the system.  This includes, but is not limited to, the uploading or creation of computer viruses.  Any vandalism will result in the loss of computer services, disciplinary action, and legal referral.



REQUIRED SIGNATURES

I have read this contract and agree to abide by the terms and conditions of the contract.



District-User’s Name (please print)                                                                                                                   

Signature                                                                                                          Date                                         

School/Student-User Electronic Information Resource Contract



Electronic information services are available to students, teachers and staff in our district who qualify.  Our goal in providing this service is to promote educational excellence by facilitating resource sharing, innovation, and communication.  The Hueneme School District will make every effort to protect students and teachers from any misuses or abuses of the information service.  All users must be continuously on guard to avoid inappropriate and illegal interaction with the information service.



Please read this document carefully.  When signed by both student and a parent/guardian,

it becomes a legally binding contract.



Listed below are the provisions of this contract.  If any user violates these provisions, access to the information service may be denied and you may be subject to disciplinary action.



TERMS AND CONDITIONS OF THIS CONTRACT



1. The BASIC STANDARD OF BEHAVIOR when using an electronic resource, is the same standard of behavior that is practiced and used in each classroom and on each school campus in the Hueneme School District.

2. PERSONAL RESPONSIBILITY.  As a student or parent/guardian, I will accept personal responsibility for reporting any misuse of the network to the system administrator.  Misuse can come in many forms, but it is commonly viewed as any messages sent or received that indicate or suggest pornography, unethical or illegal solicitation, racism, sexism, inappropriate language, and other issues described below.

3. ACCEPTABLE USE.  The use of my assigned account must be in support of education and research and with the educational goals and objectives of the Hueneme School District.  I am personally responsible for this provision at all times when using the electronic information service.

a. Use of other organizations’ networks or computing resources must comply with rules appropriate to that network.

b. Transmission of any material in violation of any United States or other state organizations is prohibited.  This includes, but is not limited to: copyrighted material, threatening or obscene material, or material protected by trade secret.

c. Use of commercial activities by for-profit institutions is generally not acceptable.

d. Use of product advertisement or political lobbying is also prohibited.

4. PRIVILEGES.  The use of the information system is a privilege, not a right, and inappropriate use will result in a cancellation of those privileges.  Each person who receives an account will participate in a discussion with a Hueneme School District faculty member as to proper behavior and use of the network.  The District system administrator(s) will decide what is appropriate use and their decision is final.  The system administrator(s) may close an account at any time if necessary.  The administrator, staff, or faculty of the District may request that the system administrator deny, revoke, or suspend specific user accounts.

5. NETWORK ETIQUETTE.  You are expected to abide by the generally accepted rules of network etiquette.  These rules include, but are not limited to, the following:

a. BE POLITE.  Never send, or encourage others to send, abusive messages.

b. USE APPROPRIATE LANGUAGE.  Remember that you are a representative of our school and district on a non-private system.  You may be alone with your computer, but what you say and do can be viewed globally!  Never swear, use vulgarities, or any other inappropriate language.  Illegal activities of any kind are strictly forbidden.

c. PRIVACY.  Do not reveal your home address or personal phone numbers of students or colleagues.

d. ELECTRONIC MAIL.  Electronic mail (e-mail) is not guaranteed to be private.  Everyone on the system has access to all mail.  Messages relating to or in support of illegal activities must be reported to the authorities.

e. DISRUPTIONS.  Do not use the network in any way that would disrupt use of the network by others.

f. OTHER CONSIDERATIONS:

-	Do be brief. Fewer people will bother to read a long message.

-	Do minimize spelling errors and make sure your message is easy to understand and read.

-	Do use accurate and descriptive titles for your articles.  Tell people what it is about before they 	read it.

-	Do get the most appropriate audience for your message, not the widest.

-	Do remember that humor and satire is often misinterpreted.

-	Do remember that if you post to multiple groups, specify all groups in a single message.

-	Do cite references for any facts you present.

-	Do forgive the spelling and grammar errors of others.

-	Do keep signatures brief.

-	Don’t “attack” correspondents; persuade them with facts.

-	Don’t post to a group you don’t know.

�6. SERVICES.  The Hueneme School District makes no warranties of any kind, whether expressed or implied, for the service it is providing.  The District will not be responsible for any damages you suffer while on this system.  These damages include loss of data as a result of delays, non-deliveries, mis-deliveries, or service interruptions caused by the system or your errors or omissions.  Use of any information obtained via the information system is at your own risk.  The District specifically denies any responsibility for the accuracy of information obtained through its services.

7. SECURITY.  Security on any computer system is a high priority because there are so many users.  If you identify a security problem, notify the system administrator at once.  Never demonstrate the problem to other users.  Never use another individual’s account.  Any user identified as a security risk will be denied access to the information system.

8. VANDALISM.  Vandalism is defined as any malicious attempt to harm or destroy data of another user or any other agencies or networks that are connected to the system.  This includes, but is not limited to, the uploading or creation of computer viruses.  Any vandalism will result in the loss of computer services, disciplinary action, and legal referral.



REQUIRED SIGNATURES



STUDENT 	Date                                       



I understand and will abide by the provisions and conditions of this contract.  I understand that any violations of the above provisions may result in disciplinary action, the revoking of my user account, and appropriate legal action.  I also agree to report any misuse of the information system to the Hueneme School District system administrator.  Misuse can come in many forms, but can be viewed as any messages sent or received that indicate or suggest pornography, unethical or illegal solicitation, racism, sexism, inappropriate language, and other issues described above.



Student’s Name (please print)                                                                Signature                                                                          



PARENT OR GUARDIAN 	Date                                       

As the parent or guardian of this student, I have read this contract and understand that it is designed for educational purposes.  I understand that is impossible for Hueneme School District to restrict access to all controversial materials, and I will not hold the District or staff responsible for materials acquired on the network.  I also agree to report any misuse of the information system to the Hueneme School District system administrator.  Misuse can come in many forms, but can be viewed as any messages sent or received that indicate or suggest pornography, unethical or illegal solicitation, racism, sexism, inappropriate language, and other issues described above.

I accept full responsibility for supervision if and when my child’s use is not in a school setting.  I hereby give my permission to issue an account for my child and certify that the information contained on this form is correct.



Parent’s/Guardian’s Name (please print):                                                          Signature                                                               



SPONSORING TEACHER 	Date                                       

I have read this contract and agree to promote this agreement with the student.  Because the student may use the network for individual work or in the context of another class, I agree to instruct the student on acceptable use of the network and proper network etiquette.  I also agree to report any misuse of the information system to the District system administrator.  Misuse can come in many forms, but can be viewed as any messages sent or received that indicate or suggest pornography, unethical or illegal solicitation, racism, sexism, inappropriate language, and other issues described above.



Teacher’s Name (please print):                                                                 Signature                                                                        



�



Permission Slip for World Wide Web Home Page

Electronic information services are available to students, teachers and staff in the Hueneme School District. The goal in providing this service is to promote educational excellence by facilitating resource sharing and communication.



Your permission is requested to use your child’s work/photo on the Hueneme School District’s World Wide Web Homepage.



The Hueneme School District has my permission to use the work/photo of my child in conjunction with the district’s homepage on the World Wide Web. I understand that my child’s first name and last initial, name of the school, teacher’s name and grade may be used. I further understand that there will be no compensation for the use of my child’s work/photo.



Student’s Name (please print)



Date



Parent’s/Guardian’s Name (please print)



Signature



( 1997. Microsoft Corporation. All rights reserved.



2. Internet/Intranet

Web Authoring, Publishing, and Management: Microsoft Office Family of Products in K-12 Education

By Suzanne Sowinska, Ph.D.



This is the first of a two-part series on Microsoft products and Internet/intranet development in the K-12 environment.  This month we interview Katie Jordan, Education Product Manager for the Microsoft Office family of products being used in education. Next month we’ll focus on Microsoft Developer products for programming, development, and Web site administration.



Whether you are a teacher trying to create your first Web page, a high school student trying to publish a school newspaper on the Web, or a site technology coordinator managing a school Web site, one glance at the Internet products available from Microsoft (http://microsoft.com/products/inteprod.asp) is enough to make your head spin with choices.  Microsoft( products make it very easy to create, publish, and manage Web pages and Web sites, but there are so many different products to choose from.  How do you decide what software program will work best for your school?  What if you are happy with the product you are using but want to know if an upgrade will make your job easier?  What if you already have a school Web site but you want a product that will make it easier to manage?  Katie Jordan, once a fifth-grade teacher herself, gives an inside Microsoft view of Creative Writer 2.0 and just a few of the Office family products that can really make a difference for K-12 educators and those supporting them. No matter which products you choose, all pages and sites created with these products can be viewed in either Microsoft( Internet Explorer or Netscape.

What Internet and Web development products do you recommend for each type of user? (i.e. for K-12 students, for teachers, for administrators, and for site technology coordinators)

Microsoft Word 97, Microsoft Publisher 97, and Creative Writer 2.0 are great for students, teachers, and administrators who want to create Web pages. FrontPage( 97 was designed to help users manage entire Web sites. In fact, almost every new product coming out from Microsoft includes features that let users easily create material for the Internet/intranet, as well as access the Internet/intranet through these products.  For example, in Microsoft Word 97, you can publish Word documents as Web pages.  You can also view a Web page in Word without having to switch to a separate browser.



I recommend these Office products for K-12 educators involved in creating Web pages and managing Web sites:

For younger K-12 students: Creative Writer 2.0, Publisher 97

For older K-12 students: Publisher 97

For K-12 teachers: Creative Writer 2.0, Publisher 97, Word 97, and the FrontPage 97 

For administrators: Publisher 97, Office 97, and the FrontPage 97 

For site technology coordinators: the FrontPage 97 and Office 97

What products do you recommend most for school districts just getting into creating a Web site or an intranet?

All of the Microsoft products I’ve recommended for K-12 educators have Internet features that make authoring or viewing Web pages easy to do. In addition, FrontPage 97 gives educators quick access  to professional quality Web site publishing without needing to know any programming.  If you are just getting into Web authoring or management, here are some criteria to consider when choosing which software to use:

Choose a product you already know and like. Rather than having to learn a new product in order to create Web pages, students and teachers can use the product that they are familiar with.  For example, if you’ve been using Word to create documents, in Word 97 you can click Save as HTML on the File menu to save a document as a Web page.  Or, you can insert a Word document into a Web page.

Choose a product you already own.  If you own Publisher 97, take advantage of the Web Site Page Wizard to develop a new publication. To make any existing Publisher publication into a Web site, choose Create Web Site From Current Publication from the File menu. 

Choose a product to match the size of your Web site.  Office 97 and Publisher 97 are ideal for creating small Web sites.  If you are planning an intranet or large Web site with multiple Web page authors, you’ll want to use FrontPage. With FrontPage, you can import (or drag and drop) any HTML, Office, or other content to your Web site. 

Choose a product that matches the sophistication and technical level of the user.  Creative Writer is a great product to use with younger students creating their first Web page.  Older students will find more sophisticated features in Publisher 97 or FrontPage.  

Choose a product that fits with how active you want your Web pages to be.  Word 97, Publisher 97, and Creative Writer 2.0 allow you to add basic components like hyperlinks, buttons, and e-mail reply forms to your Web pages.  However, if you want to add more sophisticated features like ActiveX controls and Visual Basic Script, or if you want to create JavaScript or threaded discussion bulletins, FrontPage 97 is the tool for you. Just move your existing content into FrontPage 97, and then add the functionality you want.

Choose a product that allows you to both start from scratch and work with the files you already have.  All the Office 97 products allow you to take previous version of files and save them as HTML files that can be used on the Internet.  Using the new Import Web wizard in FrontPage 97, you can convert an existing Web site into a FrontPage Web. Then you can use features like Global Find and Replace, the Global Spell Checker, or Hyperlink Update and make quick changes to all your Web pages at once. Last but not least, If you rename or move a file in FrontPage Explorer, FrontPage will automatically update all links to that file on other pages(a real time-saver.

What products do you recommend for school districts that already have a Web site or intranet?

FrontPage 97 is the ideal product for combining existing HTML files or applications and putting them into an environment that makes it easy to manage the site.  The new Import Web Wizard allows users to import folders of HTML or other document types into FrontPage; they can add the folders to an existing Web site or make them part of a new Web site.  The Image Composer, a tool for creating and modifying graphics, is included with FrontPage with Bonus Pack and it’s fun to use!  FrontPage 97 is also designed to work with Microsoft Office(it uses the same set of text converters as Office 97, shares same Clip Art Gallery for graphics, and shares the same toolbar look and much of the same functionality.  



(For more information on FrontPage and Internet development, see the article in last month’s K-12 Technology Connection newsletter. From this newsletter’s home page, click the Past Issues button.)

What products make the job of the network administrator and site technology coordinator easier?

When the FrontPage 97 Bonus Pack was created, a significant amount of development time  was spent adding functionality that takes advantage of the best that the Internet and intranets have to offer. With the Database Connection Wizard, for example, it’s now easy to have dynamic database queries in a FrontPage Web site, giving users the ability to get up-to-the minute information from a database in real time. WebBots( are another good example: these are CGI scripts that let users have powerful interactive functionality in their Web sites without having to program or write code. 



The FrontPage vision of bringing the ability to create and manage professional Web sites to a broad base of users is really helping K-12 technology coordinators.  Those administering Internet servers, managing an intranet, or developing school district intranets should take a close look at FrontPage features by visiting our site at http://www.microsoft.com/frontpage/.



What’s a not-so-obvious feature in an Office product that will really help jazz up an existing Web site?

One feature that comes to mind is the ability to save a slide show or presentation that you’ve created in Office 97 as an animation.  Visitors to your Web site can then view the slide show from a Web page.  It’s really easy to do: if you’re using PowerPoint 97, just click Save As HTML from the File menu, and then choose the Animation Player option in the wizard.  If you’re using PowerPoint 95, you can download the PowerPoint Animation Player for ActiveX or PowerPoint Internet Assistant for free from the Office Web site at http://www.microsoft.com/office/.

What’s your own personal favorite Internet development feature?

My personal favorite is the Web page wizard that you can find in Word 97, Publisher 97, FrontPage 97, and Creative Writer 2.0. Web page wizards make it easy for anyone to create their own home page or project page. In FrontPage, my favorite is the ability to quickly create a Web site and use existing materials that were developed in any format(HTML, Office document types, and so forth. You can even drag a Word document onto the FrontPage editor and it will automatically be converted to HTML.



Here’s another great idea: students can use these tools to create a school project site and then use the site on an individual computer running the Microsoft Person Web Server with FrontPage 97. What I like even more is the fact that all the products mentioned in this article(FrontPage 97, Publisher 97, Office 97( work well together to help schools create Web pages and Internet or intranet sites.



About the author: Suzanna Sowinska is a software consultant, technical writer, and university educator.

Visit Microsoft on the Web and See What Katie Jordan is Talking About

For more information on the Office products discussed in this article:



Microsoft Office 97: http://www.microsoft.com/office/

Microsoft Publisher 97: http://www.microsoft.com/publisher/

Microsoft FrontPage 97: http://www.microsoft.com/frontpage/

Microsoft Creative Writer 2.0: http://microsoft.com/kids/creative2.htm

Microsoft Word 97: http://www.microsoft.com/word/

Microsoft Microsoft Excel 97: http://www.microsoft.com/excel/

Microsoft PowerPoint 97: http://www.microsoft.com/mspowerpoint/



Other Useful Microsoft Office 97 Product Links: 



In and Out of the Classroom with Publisher 97. Teacher guide includes lessons for creating one page and multiple page Web sites: http://www.microsoft.com/publisher/io97/

Learn How to Create a Web Page From Scratch, Create a Web Page with the Web Page Wizard and Convert a Web Document to HTML by using the Word 97 Web Authoring Tutorials at http://microsoft.com/officefreestuff/word/tutorials/startfinish/start.htm

Free download of Internet Assistant for Word: (also available for Microsoft Excel 95, PowerPoint 95, Access 95) from http://www.microsoft.com/word/Internet/ia/

Free download of the PowerPoint Animation Player: http://www.microsoft.com/powerpoint/internet/player/default.htm

Free download of the Word, PowerPoint, and Microsoft Excel Viewers: http://www.microsoft.com/office/internet/

Free download of the Web Publishing Wizard: http://www.microsoft.com/msdownload/webpost.htm

Free download of some add-ons to Microsoft Office: http://www.microsoft.com/officefreestuff/



( 1997. Microsoft Corporation. All rights reserved.



Tip: Creating an Image Map in Microsoft FrontPage 97



If you’re using a text-based HTML editor, image maps (graphics with embedded hot spots or links) are almost more trouble than they’re worth. You must place the graphic on your page and then meticulously map out the coordinates of the link areas within the image. Fortunately, FrontPage( 97 Web authoring tool makes it easy to create image maps, allowing you to transform virtually any image on a Web page into a set of hyperlinks. 



To create an image map, you follow these simple steps. First, launch Microsoft( FrontPage 97 and open the web in which you want to create the image map. Then, in the FrontPage Explorer, double-click the page on which you want your image map to appear. The page will open in the FrontPage Editor. If the graphic you plan to use as the basis of your image map doesn’t yet appear on the page, select Image… from the Insert menu and, in the resulting dialog box, locate the graphic you want to use. For our example, we used a sample image from the FrontPage tutorial, located at C:\Program Files\Microsoft FrontPage\data\Tutorial\Desserts.gif. 



When the graphic appears onscreen, click on it to select it. At this point, the FrontPage Editor should place selection handles around the graphic. You’ll also see the Image palette, which offers a variety of tools you can use to create link areas within your graphic image. From the Image palette, select the Rectangle tool. Then, place the tip of the mouse pointer in the upper-left corner of the area in your graphic you want to define as a hyperlink. The mouse pointer changes to resemble a pencil. Press the mouse button and drag to the lower-right corner of the link area. For example, if you placed the Desserts.gif graphic on your page, you might draw a rectangle around the plate of cookies on the right side of the image. You can use the selection handles displayed around the boundaries of the link area to adjust its size and position.



When you release the mouse button, FrontPage will display the Create Hyperlink dialog box. From this dialog box you can establish a link destination to a new page, another page in the current FrontPage-based web, an existing page on the WWW, or a bookmark on the current page.  Select the appropriate tab in the dialog box and supply the URL, bookmark, and target frame information. For our example, we selected the World Wide Web tab and supplied the http://www.nabisco.com. Click OK to close the Create HyperLink dialog box and add the image map coordinates to your page. You can repeat this process as often as necessary to create the individual links in your image map.



To see the result of your work, simply click the Preview In Browser button on the toolbar. FrontPage launches Microsoft Internet Explorer and displays your Web page. Click on the link area you defined within your image—in this case, the plate of cookies. Microsoft Internet Explorer will treat the image map area exactly like it would treat a <A HREF> tag in your text and launch the page to which you linked it.



(1997. All rights reserved. Reproduced from Microsoft Web Builder at http://www.cobb.com/mit with permission from The COBB Group, a division of Ziff-Davis Publishing at http://www.cobb.com/.



Tip: Installing NCSA or CERN-Style Image Maps When Upgrading From FrontPage Personal Web Server for Windows Version 1.0 to 1.1



When you upgrade Personal Web Server to version 1.1, you can use NCSA- or CERN-style clickable images.



To use NCSA or CERN images, follow these steps:



1. Install the NCSA or CERN clickable image program.

2. Copy the imagemap.exe file from the \Program Files\Microsoft FrontPage\bin\ directory to the content\cgi-bin directory.

3. Copy the htimage.exe file from the \Program Files\Microsoft  FrontPage\bin\htimage.exe directory to the \content\cgi-bin directory.



Note: If you have installed FrontPage 1.1 to a different folder, you must modify the executable paths in the configuration files.



4. Use the following steps to add an alias for the NCSA or CERN clickable image programs in your Srm.cnf file:



a. In a text editor such as Notepad, edit the c:\fpserver\conf\srm.cnf file.



b. Add the following lines to the end of the file:



     WinScriptAlias /cgi-bin/imagemap/   c:/content/cgi-bin/imagemap.exe/

     WinScriptAlias /cgi-bin/htimage/    c:/content/cgi-bin/htimage.exe/



( 1997. Microsoft Corporation. All rights reserved.

Tip: Creating a Scrolling Marquee



Q. I frequently see Web pages with text that scrolls across the screen, much like you’d see on a matrix board at a sporting event. I’d love to add that feature to my site, but I don’t know anything about scripting. What’s the easiest way to make text scroll across a Web page?



A. This increasingly popular feature is called a Marquee. The text in a Marquee can slide or scroll across your screen, often over a colored background. Although it looks complicated, a Marquee is actually quite easy to create.



The first thing you should know about a Marquee is that it requires no scripting at all. The Marquee is an HTML tag that accepts parameters defining the type of movement it exhibits, the size and color of the background, the speed of the movement, and the text it displays. For example, a Marquee that slides text through the middle of a 30 pixel tall green box would require the following HTML definition:



<marquee align="middle" behavior="slide" bgcolor="#008000"

direction="right" height="30" width="100%">My first Marquee</marquee>



However, if you use FrontPage 97, you can create and control the Marquee tag from a dialog box. To build a Marquee like the one we define above, first open a page in the FrontPage Editor. Then, select the area in your document where you want the Marquee to appear. Next, choose Marquee… from the Insert menu to display the Marquee Properties dialog box.



Now, type My First Marquee in the Text dialog box. Then, select Slide from the Behavior options. Next, click the Specify Width option and accept the default setting of 100% to make your Marquee span the width of your page. Select Specify Height and type 30 in the Specify Height text box. Click the In Pixels option to establish a height setting of 30 pixels. From the background Color dropdown menu, choose the green background color. FrontPage will automatically supply the correct hexadecimal equivalent.



Finally, choose Middle from the Align With Text options. Although we didn’t do so, you can choose the direction and speed settings, as well. Click OK to close the Marquee Properties dialog box. Your Marquee is now ready to use—and you didn’t write a single line of code.



To see the Marquee in action, simply click the Display In Browser button. Microsoft Internet Explorer will display your page and activate the Marquee. After you’ve observed the Marquee’s behavior, close Internet Explorer to return to your page.



If you want to change the behavior of the Marquee, just double-click the Marquee in the FrontPage Editor. FrontPage displays the Marquee Properties dialog box, in which you can alter the original settings.





(1997. All rights reserved. Reproduced from Microsoft Web Builder at http://www.cobb.com/mit with permission from The COBB Group, a division of Ziff-Davis Publishing at http://www.cobb.com/.





Troubleshooting: Microsoft FrontPage Version 1.1 and FrontPage 97



Q. When I create multiple hotspots of the same shape, sometimes the hotspots duplicate themselves, which I can see by looking at the source code. I am using Microsoft( FrontPage( version 1.1.



A. This duplication of hotspots occurs if you rename the page. 



To work around this problem, use the following steps:



Delete all of the unwanted image maps.

Right-click the image, and click Properties to bring up the properties of the image.

In the Image Properties dialog box, click Extended.

Select each of the extended attributes and click the Delete button.

Save the file.



Now you can safely rename the file by clicking Save As in FrontPage Editor. Once you’ve saved the file with a new name, you can delete the original file.





Q. When I use the Microsoft Web Publishing Wizard to publish a Web, the WebBot( Components listed below didn’t operate. I am using FrontPage 97.



WebBot Confirmation component

WebBot Discussion component

WebBot Registration component

WebBot Save Results component

WebBot Search component

FrontPage Server-side Image Maps



A. These WebBot components require that the FrontPage Server Extensions are installed on the server. The Microsoft Web Publishing Wizard is not designed to detect the presence of these components.



Note: This behavior is different from FrontPage 1.1. The FrontPage 1.1 Web Publishing Wizard displays a list of pages that will not function correctly without FrontPage server extensions. The FrontPage 1.1 Web Publishing Wizard will not function with FrontPage 97. In FrontPage 97, the Microsoft Web Publishing Wizard is a FrontPage 97 Bonus Pack component.



FrontPage generates client-side and server-side image maps by default. The client-side image maps do not need the FrontPage server extensions to function. NCSA, CERN, and Netscape image maps will continue to work if you use them on both source and destination Webs. If you are using one of these imagemap types, server-side image maps will function correctly.



If the destination server has the FrontPage Server Extensions installed, all WebBot Components should function correctly even if they are posted using the Microsoft Web Publishing Wizard version 1.1.



( 1997. Microsoft Corporation. All rights reserved. 





3. Networking

Technology Makes New Hampshire School Run More Efficiently

Switching to Windows NT went smoothly, and school operations didn’t miss a beat. 



When Felicia Donovan began working three years ago as technology coordinator at Stratham Elementary School in Stratham, New Hampshire, the former high school English teacher and computer magazine writer understood the importance of linking technology and curriculum. But that didn’t prepare her to install a new local area network operating system.



Voters in the coastal bedroom community, located about an hour commute from Boston, had backed a local tax for new technology at the 700-student K-6 school. Because each school in the local administrative unit acts as its own sort of “sub-district” there was not a lot of continuity in technology planning, nor much in the way of a district technology support. 



“The town approved hiring a technology coordinator first, then the acquisition of new computer equipment,” Donovan recalls. “The technology committee recommended a Windows-based platform, and we started with a Novell local area network.”



For a network novice, it was a rough start. “It was a bear,” she says. “It wasn’t user friendly.” Working with a parent who had network installation experience, the LAN was up and running a 26-PC network. 



A year later, when a donation from a local company enabled the school to expand the network and add more PCs, Donovan and the school opted for a change to Microsoft( Windows NT( Server network operating system. “It cost less to upgrade to Windows NT,” she says. “Stratham’s LAN now supports 90 PCs, most of them Windows-based 486DX classroom computers.”  



But there was more to Windows NT than price and capacity. “The ease of installation and use was dramatic,” she says. “I took a two-day course in Windows NT and was able to set up the entire network by myself,” Donovan says. “It loaded fine, it ran fine. The first time we turned it on, my heart was in my mouth. But the network came up. Windows NT is all point-and-click, drag and drop. It is very intuitive.”



Moreover, when the parent who had assisted with the first network added a drive to the network file server, the Windows NT network never missed a beat. “The beauty of NT is that it recognized it right away,” she says. “We set up a Macintosh application (the Mac-School student information management library) right to the server without a single moment of down time.”



The Windows NT network delivers several applications that are used by teachers, administrators, and students. About the time the Windows NT Server began working, so did a 100-license Microsoft® Mail e-mail application. It is used by teachers and administrators(no students allowed.



“It is our primary source for communicating things like daily notices,” Donovan says. “It saves us a ton of money and labor, compared to printing out paper notices and putting them in everybody’s mailbox. Now everything goes out over e-mail and everybody is responsible for checking the e-mail.” Microsoft Works is also delivered via the network. Administrators use the Works spreadsheet for budget planning and preparation. The Works word processing package is the standard for administrators, teachers and students at Stratham, although a Microsoft Word (word processing) package is used to publish the school newspaper.



Even young students learn how to work with Works, particularly its word processing software. “Students use Works running off the network in second grade, and the second graders do fantastic things,” Donovan says. “They have a six or seven-week segment during which they learn how to change formats and fonts and do clip art. Once you learn a Windows application, it is usually very intuitive across products. You simply do the same types of things to make an application work.”



Reprinted with the permission of the publisher of Curriculum Administrator, November 1, 1996, Stanford, Connecticut.



Comparing Windows NT Server and IntranetWare as Intranet Foundations



By Bob Kelly, Product Manager, Windows NT Server Operating Systems



If your school or district is thinking about upgrading your existing network, or building a network from scratch, one of the most important issues you need to think about is that system’s intranet capabilities. Intranets, however, are only as good as the networking operating systems they are built on.



This article begins with an overview of how an intranet and an operating system work together, followed by a comparison of the basic design of the Microsoft( Windows NT( operating system and IntranetWare, an intranet platform built on the foundation of Novell’s NetWare® 4. 



What Is an Intranet?  



An intranet is the natural evolution of traditional network services. In the last few years, the Internet established a new paradigm for access to information.  The intranet borrows this paradigm and applies it on a smaller scale: having an intranet is like having your own internal Web site. The functionality is the same, but the information and pages are ‘internal’ to your organization. In a nutshell, an intranet is a combination of existing LAN and WAN technologies and new Internet technologies.



If yours is a typical district, you probably connect to information on your network using several different client applications to access different back-end services such as application communications, host connectivity, and messaging. You probably use one software package for administrative tasks, another for your database, another for e-mail, and another to explore files and documents. Complicating matters further, you may use a combination of PC and Macintosh desktop hardware for accessing these back-end services. Working this way places more demands on the network since each client application uses up bandwidth and memory—never mind the task of managing the network or training teachers and students on many different user interfaces.



An intranet enables schools or districts to simplify the data access/multiple-client conundrum. All of the clients required to access multiple data stores can be collapsed into one integrated client(your Web browser. With the right server platform, accessing existing back-end services becomes seamless. Users see a single front-end(HTML pages viewed through a Web browser(and can access information easily and efficiently, thanks to hyperlinks. For example, while storing information has always been easy on file servers, accessing it has not been as simple and just finding the right file is sometimes a challenge. With an intranet, that same content is published as Web pages and is available to everyone who has access rights. Teachers, students, and administrators have a simple way to create and distribute information, and they can edit or update it easily. Finally, component technologies like Java® and ActiveX™ provide rich, active rendering of all types of content.



What Makes a Good Network Operating System a Good Intranet Platform?



The cornerstone to building a powerful, smoothly functioning intranet platform is selecting an operating system with a multipurpose design. The network operating system you choose needs to provide file and print services, robust and scaleable application services, directory services, legacy host connectivity, and messaging, systems management, and Web publishing services. In addition, these features must be integrated, comprehensive, and easy to install, manage, and use; educators especially do not have the time, budget, or resources to re-create their entire infrastructure. 

Windows NT Server 4.0 Architecture



By using modern microkernel architecture, Windows NT Server was designed from the ground up to be a multipurpose server operating system. This means that Windows NT Server is modular and that new modules or “pieces” of the operating system can be written and plugged in without rewriting the entire operating system. For example, when Internet/intranet technologies became increasingly important over the past year, Microsoft created Internet Information Server and plugged it right in to Windows NT Server—without rewriting the entire operating system. Because of this flexibility, Windows NT Server can accommodate new technologies as they come along(building on your initial investment.



The modern architecture of Windows NT Server allows it to fill many different needs. One of the most important needs of education is for an excellent applications server. With each release of Windows NT Server, Microsoft is able to make substantial changes to the individual modules of the operating system to improve performance. Applications performance is no exception. 



Robust operating systems protect themselves from bugs in applications and even in their own subsystems through the use of this microkernel. In this architecture, the most basic operating system services are implemented in their own specially-protected subsystem—the microkernel.  The microkernel handles basic scheduling, memory management, error handling, I/O activities, and security.  Applications request services not from this kernel, but from higher level subsystems that are protected from each other and serve as a protective intermediary for the microkernel. Without this protective intermediate layer, bugs in applications or subsystems themselves can crash the system.  Microsoft implemented this design in Windows NT Server to meet the rigorous objective of reliability—whether for serving applications on your intranet or over the Internet itself.



In addition to microkernal architecture, here are three more important reasons why Windows NT Server is an excellent applications server and intranet platform:



Protected memory: separation between an application’s memory address and kernel memory address.  If an application crashes, your server won’t.

Asynchronous I/O: the ability for an operating system to handle multiple I/O requests without standing idle. Windows NT can support more users on a given server with excellent performance.

Preemptive scheduling: the ability for the operating system to schedule processing time for threads, and to preempt one thread with another. Instead of applications appearing “frozen” as the server completes tasks or monopolizes the system for other users, the user experiences a continuously interactive system.



IntranetWare Architecture



NetWare, the foundation upon which Novell has bundled its intranet services, was designed primarily for file and printer sharing, and it has been excellent for that purpose. However, because of this singular design, IntranetWare lacks the basic system services necessary to support client-server applications. In fact, IntranetWare is built on legacy architecture and offers no new functionality with respect to applications support. 



What was NetWare’s original design goal? The initial purpose of NetWare was to make the user think that the file server was just another disk drive in the user’s machine.  A user’s F:\ drive appeared as if it were part of their machine, even though it was located elsewhere on the network.  For example, if a user, Mary Smith, were to open a word processing document from her F:\ drive, she would use the File Open command the same way she would for a file on her machine’s internal C:\ drive.  In theory, the performance should not be noticeably different.



Novell’s focus, therefore, was to design a network operating system for high-performance file and device sharing on Intel 386 servers with 6MB of RAM and hard disks that are slow by today’s standards. This hardware profile was the mainstream installed base of network file servers in the late 1980s when NetWare was designed. 



This architectural heritage is pervasive in the mature foundation of NetWare 4.X and IntranetWare. The value of this focus on fast network data transfer is reflected in good performance on very small systems.  However, the trade-off in functionality is the lack of a robust foundation layer for today’s applications. To address this lack, Novell extended NetWare to run certain applications as NetWare Loadable Modules (NLMs). NLMs were designed, however, as an afterthought to the operating system and in themselves, cannot provide the foundation required to run applications with reliable high-performance.  



As mentioned earlier, a solid intranet platform needs protected memory, asynchronous I/O, and preemptive scheduling. Here is what IntranetWare offers in these areas:



Memory protection only in debug mode: An application failure can crash your server, making your intranet unavailable.

No asynchronous I/O: Applications can easily block the rest of the system when communicating with the network or the disk. For example, a single user querying Novell Directory Services (NDS) for all users in a certain department could block the server while the system retrieved the locally stored directory partitions.

Limited preemptive scheduling: some key system services still use NetWare’s cooperative scheduling model. NetWare 4.11, the multiprocessing version of NetWare that can exploit Intel-based servers with four processors and the basis for IntranetWare, has a preemptive scheduler but NLMs will have to be modified extensively to take advantage of it.  Unmodified NLMs will continue to use the first-in/first-out model that is identical to NetWare 4.1’s cooperative multitasking.  In addition, one major subsystem remains non-preemptible:  any tasks involving the disk drives have to go through a piece of the system that is bound to a single processor, making I/O tasks a significant bottleneck to scaleability.  Applications such as databases, messaging systems, and communications programs will all be constrained by this limitation.. 



Comparing IntranetWare and Windows NT Server as Intranet Platforms 



By focusing on the platform instead of the features, you can get a better idea of how each of the server operating systems solves your intranet needs. Fundamentally, IntranetWare is a special purpose (file and print) server operating system with intranet technologies added on.



Deploying IntranetWare as an intranet platform only gives you a portion of what you need: it gives you good file sharing capability and allows you to share those files using the Internet paradigm (hyperlinks and graphics). But you still have to install a multipurpose, reliable applications platform (such as Windows NT Server or some variant of UNIX) and then you have to integrate the two operating environments—a time consuming and costly affair. This means more work for you, not to mention the costs of multiple administrative models. 



Windows NT Server is an all in one intranet solution. For example, with Windows NT Server, when you create or modify a user account, you do it once for all services. With IntranetWare and whichever applications platform you choose to run with it, you will do everything twice. Additionally, in this scenario there is no integration between the directory or security models of the two operating environments. 



Since many of the services offered in IntranetWare are actually licensed from other vendors (NetBasic from HiTechSoft, Netscape Navigator, and Novell’s Web Server from American Web), you cannot be assured that they will work well together. With Windows NT Server 4.0, all of the services in the operating system are from Microsoft and are fully and totally integrated—both with the operating system and one another.



While IntranetWare does in fact make some improvements in ease of deploying, managing and using NetWare, it does not approach the ease that Windows NT Server 4.0 offers. For example, IntranetWare offers no real graphical interface, except for the utilities NWAdmin, NDS Manager, and NAL, and these tools only run on a client machine that an administrator uses to manage the Intranet. While IntranetWare offers some enhancements to the NDS administration tools to make it easier to manage and deploy NDS, there are, for example, no HTML-based tools to allow you to administer your network with a Web browser. 



In addition, Novell offers minimal support for TCP/IP, the so-called “language of the Internet.”  As pointed out by many industry analysts, NetWare’s TCP/IP (including IntranetWare) is actually IP tunneled inside of IPX, Novell’s proprietary protocol for transferring data on a NetWare-based network. This means that TCP/IP is not native to the NetWare environment and requires additional overhead to deploy.  This also means that administrators will still need to run IPX/SPX in their intranet even if they want to run just TCP/IP. Everything Novell has built to date is contingent upon IPX/SPX. This explains IntranetWare’s IPX/IP gateway—it is a necessity in an IntranetWare environment.  Meanwhile, the industry continues to use TCP/IP as the standard protocol for data transfer and communication. 



In conclusion, the Windows NT operating system offers all the tools as well as the architecture necessary for all of your intranet needs. By comparison, IntranetWare offers only a subset of the same services built upon a platform unsuited to the development of a solid intranet.



Training and Certification Programs



Get the most out of your investment in Windows NT Server with Microsoft’s comprehensive training programs. You can choose from three training options: Instructor-Led, Online, and Self-Paced. Microsoft has an extensive online course catalog. 





Here’s a sampling of the courses available today: 



•Course 661: Administering Microsoft Windows NT 4.0

•Course 685: Installing and Configuring Microsoft Windows NT Server 4.0

•Course 687: Supporting Microsoft Windows NT4.0 Core Technologies

•Course 688: Interworking Microsoft TCP/IP on Microsoft Windows NT 4.0 

•Course 689: Supporting Microsoft Windows NT Server 4.0 Enterprise Technologies 

•Course 729: Microsoft Windows NT Server Expert Series 

•Course 772: Microsoft Windows NT 4.0 Upgrade Training 





You can also take product classes over the Internet at the Microsoft Online Institute, a virtual campus on the World Wide Web. 



Finally, you can become a Microsoft Certified Professional (MCP), which will qualify you as an expert in various Microsoft products. There are many business opportunities available through Microsoft Authorized Training Programs, and you can find out about them at the Microsoft Web site at http://www.microsoft.com/ntserver/default.asp.



Windows NT Server 4.0: Feature Overview



In addition to its already abundant network services, such as directory and C2-evaluated security, Windows NT Server 4.0 adds many new features including: 



Internet Information Server 2.0 (IIS 3.0 is currently available for download at http://www.microsoft.com/windows/common/aa246.htm): IIS is a commercial-strength WWW-server, FTP-server, and Gopher server—three important, standard, cross-platform ways of sharing static information over the Internet and intranets When you install Windows NT Server 4.0, Internet Information Server is installed automatically, so you are, in fact installing an intranet platform. There is nothing to add on, nothing to integrate. Microsoft built IIS to run on Windows NT Server and take full advantage of the underlying Windows NT component architecture.  Thus, it is completely integrated with Windows NT Server and its security model—which means that the users on your network have one account, allowing them access to all network resources and your intranet—all managed from a centralized administration point.  Access to specific areas on your intranet is managed the same way you would manage any of your other network resources like printers, files, and folders.

Windows 95 User Interface: Familiar interface significantly reduces training time.

Administrative Wizards: Wizards centralize common server management tools and walk you through the steps required for each task. The following wizards make common administrative tasks simple: Add User Accounts: Group Management: Managing File and Folder Access: Add Printer; Add/Remove Programs; Install New Modem; Network Client Administrator; and the License Wizard.

Network Monitor: Powerful diagnostic tool enables easy troubleshooting of network problems.

System Policy Editor and User Profiles: These features help you manage user desktops and maintain security. System Policy Editor is used for the standardization and control of the desktop. User profiles contain all user-definable settings. Both policies and profiles can be stored on a network server, so individuals users can always access the same desktop, regardless of location.

Task Manager: Provides detailed information on each application and process running on the workstation. Also provides information on memory and CPU usage. 

Improved Windows NT Diagnostic Tools: Provide easy graphical system examination. Many of the Win32® tools used to administer Windows NT Server are also available in HTML format, meaning you can administer your server either locally or remotely, with either the standard Win32 tools or a Web browser that supports frames (such as Microsoft Internet Explorer or Netscape). Perhaps best of all, all of the built-in services in Windows NT Server are fully integrated with the Windows NT Directory Services. 

Security: Windows NT Server provides comprehensive tools to help administrators maintain security from any single location. For example, an administrator can specifically control which users have access rights to which network resources, including files, directories, servers, printers, and applications. Rights are defined on a per-resource basis and can be managed centrally. User accounts are also managed centrally. 

Microsoft Index Server (download free at http://www.microsoft.com/windows/common/aa246.htm): Automatically indexes the full text and properties of files, including HTML.

Microsoft FrontPage( Web authoring tool: Award-winning site management and authoring tool.

Updated Novell NetWare Interoperability Services: Client and Gateway Services for NetWare have been extended to support NetWare NDS. 

Microsoft Internet Explorer 2.0 (Internet Explorer 3.0 available for download free at http://www.microsoft.com/ie/): Web browser for browsing the Word Wide Web.

File and Printer Enhancements: Improved network throughput

Improved Scaleability on Multiprocessor Systems

Domain Name System (DNS) Server and DHCP services provide the means to graphically administer a dynamic TCP/IP infrastructure, a critical component of intranet functionality.

Distributed Component Object Model (DCOM): Extends COM to allow components to communicate over networks, including the Internet/intranet.

Point-to-point Tunneling Protocol (PPTP): Provides a way to use public data networks, such as the Internet, to create a virtual private network connecting client PCs and servers.

Hardware compatibility: Windows NT is hardware-independent and supports more than 4,500 hardware systems, including X86, RISC, and multiprocessor machines. Devices tested for compatibility include hundreds of computer systems, drive systems, SCSI and non-SCSI peripherals, communications devices, cards, video adapters, printers, and accessories.

Other built-in services include Remote Access Services (RAS), MultiProtocol Routing (MPR), Telephony API 2.0, and Cryptograph APIs. 

Novell IntranetWare: Feature Overview



IntranetWare includes Novell’s Web Server, the Netscape Navigator browser, an IP/IPX gateway, and Novell’s Multiprotocol Router. IntranetWare is thus able to give users on your network basic access to the Web and other popular TCP-based intranet and Internet services. 



IntranetWare works with most Novell products, such as GroupWise, SFT III, and NetWare Telephony Services, and will continue to be compatible with third party NetWare-compatible applications. And, since IntranetWare is simply the latest edition of NetWare, you can use it with most existing Novell IPX networks. Improvements made to IntranetWare include migration utilities; hardware detection; and symmetrical multiprocessing. IntranetWare supports Internet Protocol with DHCP to simplify deployment of IP Intranets and offers an IPX/IP gateway. The IPX/IP gateway routing capabilities support ISDN, frame relay, ATM, and leased lines. 



Just as NetWare 4.x, IntranetWare uses Novell Directory Services (NDS) to manage network resources. NDS is a distributed database of all users and resources on the network. Based on the hierarchical X.500 standard, NDS is the backbone of IntranetWare’s network management. NDS represents an improvement over previous proprietary directory services in NetWare. Text-based (and some graphical) utilities are also available from Novell for other parts of the management puzzle. 



IntranetWare provides client browser and FTP support for MS-DOS™, Windows®, Windows 95, Windows NT, Macintosh, OS/2, and UNIX workstations. Clients can access the Internet while running IPX through the IPX/IP gateway.



The following features are included in IntranetWare:



Novell’s NetWare Web Server 2.5

An IPX/SPX-to-IP gateway

Multi-protocol routing 

Netscape Navigator, a Web browser for accessing the World Wide Web

Novell’s Web-page authoring tools

NetWare Application Launcher (NAL)

Symmetric Multiprocessing functionality 

TCP/IP support (actually tunneled inside of IPX)

NetBasic, a Basic scripting tool that allows access to network services and development of intranet applications—licensed from HiTecSoft.

New graphical administration tools 
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Tip: How to Manage Migrated NetWare Users Accounts                



The following procedure will help you manage migrating your NetWare accounts to the Microsoft( Windows NT( operating system. This procedure requires the NetWare conversion utilities included with Windows NT Server version 3.5 or 4.0, and the Windows NT Resource Kit versions 3.5 and 4.0.



To better manage migrating NetWare accounts, do the following:



1. Migrate the user account from a Netware Server to a Windows NT Primary Domain Controller (PDC) using the Migration Tool for NetWare (NWCONV.EXE).

2. Use the ADDUSERS command to create a comma-delimited text file of the users installed on the Windows NT Server. As an example, type the following command:



      ADDUSERS \\<ServerName> /D USERS.CSV



3. Use Microsoft Excel and the *.CSV file you created. Open the file using the CSV filter provided with Excel.

4. Copy the users column of the spreadsheet and paste this information to a text editor such as Notepad. Save as NETWARE.BAT.

5. Using an MS-DOS editor, such as EDIT.COM, open the NETWARE.BAT file.

6. To help set up the user’s home directory and share:



      a. Insert the following before the first user name:



         FOR %%X IN (<Username>)



      b. Go to the end of that line and press Delete. The next user name will move up. Go to the end of the line and press Delete again. The next user name will move up. Continue to do this, one name at a time, and fill up the line with all the users you can fit. One space is required between each user. End the line with the

command you wish executed for each user on that line.



Note: The number of users you can fit on a line varies (25 is average). It is important to ensure that no single line is greater than 255 characters (EDIT.COM program lets you know).



c. Repeat the process for all lines. For example:



FOR %%X IN (JOHN MARY GEORGE ALICE...) DO MKDIR C:\USERS\%%X

FOR %%X IN (PAM JIM LAUREN MICHAL...) DO MKDIR C:\USERS\%%X



Note: You can create as many lines as you need until each user is part of a FOR statement.



d. For each line above, add the following:



FOR %%X IN (<Name1> <Name2>... ) DO CACLS C:\USERS\%%X /G %%X:F



e. Add the following to share the USERS directory:



NET SHARE USERS=C:\USERS



7. Changing the user account information can be done with the NET USERS command. The command is robust and takes care of the majority of the changes required. To use the NET USERS command, repeat Step 6 and change the lines to read:



DO NET USERS %%X /HOMEDIR:\\<ServerName>\USERS\%%X



Note: This command adds a shared directory path to the user account in the Home Directory field of the user’s profile in User Manager. You can make adjustments to accommodate more commands as required or

repeat the process for each NET USERS command you would like to apply to the user’s account.



8. To take advantage of the home directories, add the following command to the login script (the connection is not a persistent connection):



NET USE H: /HOME



Note: The /HOME option works for both Windows NT and Windows for Workgroups systems.



9. Make copies of all the files that you created during the process of Step 8, and save them. As you make changes to the Primary Domain Controller you may wish to update these files for use with future    modifications. There are many options that can be set or changed for a large number of users.



Example Batch File



For a group of just two users (for readability), JOHN and MARY:



FOR %%X IN (JOHN MARY) DO NET USERS %%X /ACTIVE:YES /EXPIRES:06/22/95

FOR %%X IN (JOHN MARY) DO MKDIR C:\USERS\%%X

FOR %%X IN (JOHN MARY) DO NET USERS %%X /SCRIPTPATH:LOGIN.BATNET GROUP ENGINEERING /ADD /COMMENT:"ENGINEERS"

FOR %%X IN (JOHN MARY) DO NET GROUP ENGINEERING %%X /ADD NET SHARE USERS=C:\USERS

FOR %%X IN (JOHN MARY) DO NET USERS %%X /HOMEDIR:\\<Server Name>\USERS\%%X

FOR %%X IN (JOHN MARY) DO CACLS C:\USERS\%%X /G %%X:F (NTFS Only - Sets the Users Directory permissions to Full Control)CACLS C:\USERS /G EVERYONE:R (NTFS Only - Sets the USERS directory to READONLY)



The information in this article applies to:



 Microsoft Windows NT Workstation version 3.5

 Microsoft Windows NT Server version 3.5

 Microsoft Windows NT Server version 4.0

 Microsoft Windows NT Workstation version 4.0
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Troubleshooting: Windows NT Server Operating System



Q. When I use the NetWare Migration Tool to transfer user and group accounts from a Novell server to a Windows( NT server, no user accounts are transferred. Instead, I get the following message: Error: getting groups on server: servername.



A. The problem is that only the default group of EVERYONE exists on the Novell server. Create another group other than EVERYONE on the Novell server before you migrate the accounts to Windows NT.



Note: This applies to Windows NT Server version 3.51 and 4.0



Q. I’ve been unsuccessful at using the Migration Tool for Netware (NWCONV.EXE) version 1.1 that is included with the Microsoft File and Print Services for Netware  (FPNW) 3.51 to migrate my NetWare server to a non-domain controller Windows NT Server.



A. Migrate the NetWare server to a Windows NT Server running as a primary domain controller (PDC) or a backup domain controller (BDC).



Note: This applies to Microsoft Windows NT Server version 3.51



Q. When I try to migrate Macintosh volumes from NetWare to Windows NT, the NWCONV.EXE Utility corrupts files. What should I do?



A. You should transfer directories and files from a NetWare server to a Windows NT server.



To transfer directories and files from a NetWare server to a Windows NT server:



From a Macintosh client, mount both the NetWare and the Windows NT volume.

Select the NetWare directory structure and drag it onto the Windows NT directory structure.



Note: This applies to Microsoft Windows NT Workstation versions 3.5 and 3.51; Windows NT Server version 3.5, 3.51, and 4.0.



Q. When I use the Migration Tool for Netware to move groups to a Windows NT server, the Migration Tool fails without any error messages.



A. To work around this problem, rename the group name or the user name on the NetWare server and try again.



Note: This applies to Windows NT Server versions 3.5 and 4.0.
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4. On Your Desktop

Applied Computer Education Excites Teachers and Students Alike

By Liza White



“When you get the lab done, check your neighbor’s work!” Wade Wolff calls to his students over the din of a busy classroom. This is the fourth year the required freshman computer courses have been taught at Colfax High School, one of the four participating schools in the applied computer education program at Placer Union High School District located in the Sierra Foothills of northern California. The classes are designed to create a consistent software knowledge base among the students, says Dave Timpone, staff developer for the Placer Union High School District. The curriculum, developed in one of Timpone’s summer “boot camps” emphasizes the principles of applied education: computer skills, for example, are taught as part of a larger project or final product. Microsoft( Office is one of the main programs he uses, particularly Word, Excel, and PowerPoint(. 



In the freshman introductory class, each student builds a magazine from the ground up using Microsoft Word. Students learn the fundamentals of page layout and by the time they finish the project, they are proficient enough in word processing to do papers for other classes. According to Wolff, this method makes the program popular with other teachers because they don’t have to teach word processing. Best of all, students’ writing, editing, and presentation skills show considerable improvement after the class. 



Learning Industry Software

Before teaching video and computer classes at Placer High School, Molly Trainor worked in the business world. “I used Microsoft products—especially Word.” She says, “I think it’s important to teach the software that’s used in the industry—and it seems most businesses are using Microsoft products.” In her classes, Trainor focuses on skills her students will need after graduating. For example, in the magazine project, her students use the Internet to take a personality test and begin career exploration. They also start a portfolio of resumes, cover letters, and samples that they can add to through their high school years. Word processing skills become the foundation for learning other programs. “Once they know Word,” Trainor says, “everything else comes really fast.”



Spreadsheets That Count

In the second quarter, students are connected up with the Physical Education department to help turn raw data into meaningful reports for their peers. The PE department collects statistics on all the students in their classes, but this data is hard to interpret in its raw form. The students’ task is to present the material using the charting and graphing capabilities of Microsoft Excel. Each student in the computer class is matched up with a student in the PE classes and provides that student with a detailed report of their overall standing, progress, and recommendations for goal setting. In turn, PE class students evaluate the reports and determine how effective the presentation was. “So they are learning about setting up spreadsheets, finding averages, and creating charts,” Says Wolff, “But they’re also getting to apply that knowledge to meet a real need.”



Beyond the Basics

As computer proficiency grows among the students, the schools are able to offer more advanced classes and projects. At Colfax High School, students produce a high-quality printed basketball program for the girls’ and boys’ teams. To manage advertising accounts they use spreadsheet skills; to lay out pages and add content they use their word-processing and publishing skills. All the profits from the program sales go right back into funding more projects. One of the more complex new projects is to create and sell a school clothing line. Each time a project is added it creates new opportunities to apply the computer skill they’re learning. 



A Boot Camp With a Waiting List

After 20 years in the classroom, Timpone now runs computer boot camps and curriculum development workshops for teachers and staff in his district. “The program is popular,” he says, “For our two-week boot camp, we’ve had to institute a lottery to handle the demand.” It is no small wonder that the programs are popular. Teachers receive a crash course in using Exel, Word, and PowerPoint—and if they complete the program, they get a computer loaded with Microsoft Office. The same concepts used in the student computer classes are applied when training teachers and staff. During the boot camp, teachers focus on developing a curriculum and presenting it using the programs they are learning. In the Secretary program, regular classes are held to teach task specific skills, such as mail merge and spreadsheets. 



Ultimately, the goal of the program is not to teach a particular platform or set of software, but to provide students, teachers, and staff with an understanding of how they can apply computer skills to specific tasks and improve the final results. When asked why he liked the computer magazine project, one student remarked: “I got to create something and produce a final product—it made me feel like I could do anything!” 



For examples of what the Placer Union High School District students, teachers, and staff are doing with their computer skills, visit their virtual reference library at http://www.hill.puhsd.k12.ca.us/.
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About the author: Liza White, a former computer-education instructor, is a freelance writer and editor.





Tip: Using the Format Painter Tool in Office 95 and 97



Getting to know the Format Painter tool, common to all applications in Microsoft Office 95 and Office 97, will help you save time when you want to apply the same formatting to a group of objects. You can find the Format Painter tool on the Standard toolbar in Microsoft( Word, Excel, Access, and PowerPoint(. As its name implies, you use the Format uyuuh



In Word, you can copy character and paragraph formatting. 

In Microsoft Excel, you can copy cell or text formatting. 

In Microsoft Access, you can copy format characteristics from one form or report control to another. 

In PowerPoint presentation graphics program, you can copy color schemes from one slide to another, or you can copy an object’s attributes to another object. 



Taking advantage of the Format Painter tool is easy. To use it, you select the objects or cells whose formatting you want to copy, click the Format Painter tool, and then click the objects or cells to which you want to apply the formatting. As soon as you click the target object, the Format Painter tool is disabled. 



If you want to copy formatting to several objects, simply select the formatted object and double-click the Format Painter tool. Then, click each target object in turn until you’ve formatted the appropriate objects. To turn off the Format Painter tool, press the [Esc] key or select another tool. 



Using the Format Painter tool can save you lots of time you’d otherwise spend applying existing formatting to a group of objects. 



Tip: Viewing Two Sections of the Same Microsoft Excel Worksheet Simultaneously 



If you typically work with very large and complex Microsoft Excel worksheets, you may spend a lot of time scrolling to and from various sections of my worksheet. Instead of scrolling, trying viewing two sections at once.



You can use the split bars to divide a window into two or four panes. The handle for the horizontal split bar is located at the top of the vertical scroll bar; the handle for the vertical split bar is located at the right edge of the horizontal scroll bar. 



To use these bars, you point to the handle for the appropriate bar, hold down the left mouse button (or the only button on a Macintosh mouse), drag the split bar to the location you want, and release the mouse button. When you do this, Microsoft  Excel will split the window at the location of the bar. 



To remove the splits, you can issue the Remove Split command, which appears in place of the Split command on the Window menu once you’ve split a window into panes. When you issue this command, Excel will remove all the splits from the window(not just one or the other. You can achieve the same effect by double-clicking on the intersection between the splits. If you double-click on one split (instead of the intersection), Excel will remove that split but leave the other (if there is one) in place. 
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Troubleshooting: Microsoft Excel, Word for Windows, and Word for the Macintosh 





Q. When I apply bold, underline, or italic formatting to a marquee element, the bold, underline, or italic formats are not displayed in my browser. When I view the HTML source code, the tags are repositioned after the end marquee tag. I am using Microsoft( Word for Windows( 95.



A. During the conversion process, Internet Assistant creates an RTF file. During this process, it moves the bold, underline, or italic elements and places them after the marquee element. Use a text editor to manually place the bold, underline, and italic tags around the marquee element.



Q. Internet Assistant for Word offers Go Forward and Go Back toolbar buttons that allow me to quickly move between all my open documents. Since I constantly work with multiple documents in Word, I’d like to have those same buttons on a Word toolbar. Is this possible?



A. You can’t duplicate the buttons found on the Internet Assistant toolbar, but you can add buttons that will perform the same task in Word. All you have to do is drag the PrevWindow and NextWindow commands onto the desired toolbar and then assign text or an image to the buttons Word creates. Choose Customize… from the Tools menu, click the Toolbars tab, and choose All Commands from the Categories list. Then, select NextWindow in the Commands list box and drag the command name to the end of the Standard toolbar. When you release the mouse button, Word will place a blank button on the toolbar and open the Custom Button dialog box. Here, you can specify text for the button from Word’s image palette.





Q. When I update a Microsoft Excel for the Macintosh chart from Word for the Macintosh, the chart doesn’t retain its color properties. 



A. To maintain the color properties of the chart, do the following: 



Important: Steps 1-5 MUST be performed in the chart window. Copying a chart placed as an object on a spreadsheet using the Ribbon Chart Tool will not link to Word. If the chart is an object, double-click it to open it into the chart window.



In Microsoft Excel, open the Chart file and choose Print from the File menu.

Select Print Using Color, then Print Preview, and then Print.

To exit Print Preview,choose the Close button in version 3.0 or 4.0 or the Cancel button in  2.2.

From the Chart menu, choose Select Chart (COMMAND+A).

From the Edit menu, choose Copy.

Start Microsoft Word.

From the Edit menu, choose Paste Special (Paste Link in Word 4.x).

Choose the Paste Link button in Word 5.0 and 5.1.



When you Paste Link a Microsoft Excel 4.0 chart into Word 5.x, the Paste option will be set to Picture by default. If you set the option to Microsoft Excel Chart, Paste Link will be disabled. If you Paste Link as a picture, changes in the Microsoft Excel chart will be updated in the link to the Word document. 



Note: This information applies to Microsoft Word for the Macintosh, version 4.0, 5.0, 5.1, and 6.0 and Microsoft Excel for the Macintosh, versions 2.2, 3.0, and 4.0. 



To update the Microsoft Excel link in System 6.x or in System 7.x when the Link Options preference is set to Manually:



Select the chart in Microsoft Word.

From the Edit menu, choose Link Options, and then choose the Update Now button (in Word 4.0, just choose Update Link from the Edit menu).
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5. Q&A





Q. Hi! My school system is making a huge (for us) investment in PCs and MS-Office. Your newsletter is helpful. Keep it coming. I have, however, two important questions.



John Ziergiebel, Gloucester Public Schools, Gloucester MA





1. Is there a way to lock students out of the Win 95 operating system? Many of our computers are not supervised. The kids will make a mess of the operating system by going in there and clicking around. I think the answer may lie within Win95 but I am not sure. Is there a way to make each computer a shared resource on the network and lock the kids out that way OR should we buy a piece of software to do the job for us. (Trouble is, I haven't seen that piece of software anywhere.) We have used FOOLPROOF in our Mac lab with reasonable success. I'm sure there must be an easy solution. I just can't find it.



Please read “Setting Boundaries” in this issue to learn how a site technology coordinator at a  junior high school in California combined security features of the Microsoft( Windows( 95 and the Windows NT( operating system to solve the same problems you describe.



In addition, there are two products created by Windows School Connection members that can help:



FoolProof Security version 3.0 for Windows, created by SmartStuff Software at http://www.smartstuff.com/ 

WinShield for Windows 95 by  Kent*Marsh Ltd at http://www.kentmarsh.com/. 



Finally, take a look at Microsoft Plus! for Kids at http://www.microsoft.com/catalog/products/Plus/.





2. In our Mac Lab we have written our own curriculum software with HyperCard. It has been extremely successful. We would like to continue this practice as we move to the new platform (Windows 95/NT Server operating system). What would you recommend? Visual Basic comes to mind immediately. The school committee will give me the money to buy the right program. I just don't want to spend the money and time buying and learning the wrong thing. 'Done that before...



Visual Basic would be an excellent choice.  It has the same capabilities as HyperCard but can do much more. The nice thing about VB is that you create objects and connect them in any way you want.  That makes it very easy to use Visual Basic to create numerous applications quickly. Also, the new Visual Basic 5.0 Learning Edition comes complete with a training CD that is an excellent teaching tool and is great for teachers to use to learn VB themselves.  VB is the industry leader and the language underlying many programs including Office. By using this language you would also be able to customize some of your commercial software if you want.  



Several teachers have written in to ask how their schools can become beta test sites or how they can receive evaluation copies of Microsoft software.



A. You can apply to evaluate or test beta software by e-mailing BETAREQ@microsoft.com. Type the name of the product you are interested in on the subject line, then include the following information in the message:



Your name

School name

Physical address (no P.O. boxes)

Phone number

Fax number

CompuServe ID

MSN ID number

Your Internet address

Brief description of hardware and software on the PC that will be used for testing

Developers should include requests for related software development kits



If you are interested in multiple products, you must submit a separate application for each product. Please specify whether you want to evaluate or test the product and include information about previous beta testing experience. 
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6. Classroom Corner

Web Page Authoring Made Easy

By Amy Logsdon



Have you been intending to help your students make their first Web page but just haven’t gotten around to figuring out how yet? Do you have a sneaking suspicion that creating Web pages isn’t as easy as it’s cracked up to be(that you’ll probably have to spend a lot of time learning the software instead of focusing on the information you want to publish?



“Easy” is an overused word in the computer industry, but when you’re talking about the Web page wizards built into Microsoft( FrontPage( 97 Web-authoring tool, and Publisher 97, it’s accurate. Using these wizards, you can eliminate the learning curve and create high-quality pages in about half an hour. Wizards are automated, step-by-step programs that walk you through tasks such as creating a Web page: all you have to do is answer the questions and the wizard does it for you!  



Chuck Drake, teacher at Hylton High School in Woodbridge, Virginia, uses FrontPage with his students in the Advanced Computer Studies class. When the students first started making Web pages they used the wizards and “…found them very easy to use.” Then, once his students became familiar with Web authoring, they wanted to write the code for their Web pages themselves(which they can do with the newest version of FrontPage. In addition to FrontPage, they just need a scanner and a digital camera to add photographs to the school’s Web pages.



Students in the Advanced Computer Studies class say they think the wizards are pretty easy to use because as you work in FrontPage, you see exactly what your Web page will look like. One student particularly likes the graphics editing program, saying that Image Composer is top notch and great for editing Web graphics. 



Using a FrontPage97 Wizard

To create a simple Web Page using a Wizard:

Start FrontPage.

From the File menu, choose New.

Click Personal Home Page Wizard.

Select the topics you want to include in your Web site!

Follow the Wizard screen instructions to fill in the information.

When you’re finished, you’ll see the Web page you just created!

Now just insert images and type in more text to complete the page. 



To insert FrontPage clip art, such as animations, icons, and lines:

Position your cursor in the location where you want to place the art.

From the Insert menu, click Image, and then Clip Art.

Select the image category you want: for example, Icons.

Select the image you want, and click OK.

Using a Publisher 97 Wizard

To create a basic Web page using a Wizard:

Start Publisher and click Web Site Wizard at the far right of the first row.

Click Personal.

Click One Page Site.

Select the style you want, such as Basic.

Select the type of background you want.

Type the heading for your Web page. For example, Fred’s Web Site.

Select No for including addresses and telephone numbers and click Next for these two screens.

Click Create It!

When asked if you want help with more features, choose Yes or No.

The Web page is now created. Insert images and type in more text to complete the page. 



To insert Publisher clip art or pictures:

Click the Insert Picture tool and draw a border where you want the picture.

On the Insert menu, choose Picture File or Clip Art. 

Select the art you want.

To type in text, create a text box and type in the text.

Click OK.

Including Photographs on a Web Page

Before photographs can be placed on a Web page, they need to be converted to a digital graphic format, such as a GIF (.gif) or a JPEG (.jpg), by scanning the image. You can then clean up and size the image in a graphics editor, such as Image Composer which comes with FrontPage97. To insert your image into the Web page, just position the cursor where you want to locate the image click the Insert command, and browse to the location of your digitized photographs. (You can also use this method to insert art from the Microsoft Clip Art Library.) 



When you add an image to FrontPage, you can easily make the image a hyperlink by right-clicking the image to see the image properties and adding the URL, which is the Internet address of the page you want the visitors to jump to. 



Once you’ve created a Web page, the next step is getting the file placed on your Web server so that people can actually see it! If your school or district already has a Web server set up, it might be as easy as clicking the Publish button. Talk to your site technology coordinator about this.

School and Student Web Pages

Following are some links to student Web pages created using FrontPage or Publisher:



Hylton High School:  http://www.mnsinc.com/hylton  

Groveland Elementary School: http://www.minnetonka.k12.mn.us/groveland/gr.html

Stanfield Elementary School: http://www.gsh.org/schools/USA/TX/SE2839/



For more information on FrontPage and Publisher, see “Web Authoring, Publishing, and Management: Microsoft Office Products in K-12 Education” in this issue.



About the author: Amy Logsdon is an editor for user education groups at Microsoft. She also copyedits this newsletter.
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7. Products and Promotions

Products Featured in This Issue:



Microsoft( Windows® 95 Operating System: http://www.microsoft.com/windows

Windows 95 presents a major step forward in functionality on desktop and portable PC platforms by providing a system that is even easier, faster, and more powerful to use, and which maintains compatibility with the Windows and MS-DOS® operating system-based applications and hardware peripherals.



Microsoft Windows NT® Server 4.0: http://www.microsoft.com/ntserver/default.asp Powerful, easy to use, reliable, flexible, and scaleable, it all adds up to one of the world’s best network operating systems. At last, educators can expand the potential of networking in schools everywhere. 



Microsoft Office 97: http://microsoft.com/msoffice/ The world’s best-selling office suite integrates intelligent applications with the power of the Internet. For an overview of new features in Office 97, see the What’s New Checklist at http://microsoft.com/office/97tour/checklist.htm/.



Microsoft® FrontPage™ 97:  http://www.microsoft.com/education/products/prod17.htm

This Web authoring and management tool delivers a complete set of advanced Web publishing tools to Webmasters and novices alike. Designed for nonprogrammers, yet robust enough even for experienced Web site developers, Microsoft FrontPage is the fast, easy way to create and manage professional-quality Web sites. With easy-to-use functionality such as WYSIWYG editing and wizards to step you through the creation of your Web site, it’s never been easier to publish on the Web!



Microsoft Creative Writer 2: http://www.microsoft.com/kids/creative2.htm A brand new version of the award-winning creative writing and desktop publishing program. 



Publisher 97: http://www.microsoft.com/publisher/ Makes you and your students look and feel like professional publishers. Create everything from class newsletters, flyers, banners, letterhead, postcards, origami, and more in a few easy steps. 



Microsoft PowerPoint( 97: http://www.microsoft.com/mspowerpoint/ Whether conducting an informal meeting, presenting to your students, or delivering your message over the Internet, Microsoft PowerPoint presentation graphics program gives you the tools you need to communicate with impact.



Microsoft Word: http://www.microsoft.com/Word/Learn.htm Word 97 is the easy way to create powerful documents, communicate ideas, and share information anywhere from the desktop to the Internet.



Microsoft Excel: http://www.microsoft.com/office/office97/documents/xl97ds/default.htm. The world’s most comprehensive spreadsheet program.  

New Products, Betas, and Recent Releases 



Attention Educators!  We have a special promotion for schools and libraries involving Encarta 97.  This promotion allows you to receive a free copy of Encarta 97 Encyclopedia Deluxe Edition (our new, 2-CD product) for every two that you purchase at the discounted academic rate.  It’s quite a deal.  The price for each copy is $69.95 (plus shipping, handling and sales tax) but if you get two, the unit cost drops to $46.63 (plus shipping, handling, and tax) on the three copies you'll receive.  If this is of interest to you, all you have to do is call 800-615-8149 to order. 



Microsoft Encarta® 97 and Microsoft Encarta 97, Deluxe Edition: http://encarta.msn.com/LanguageChoice.asp Award-winning multimedia encyclopedias that combines comprehensive text, rich multimedia and a unique interactive environment. 



Microsoft Education Product Guide: http://www.microsoft.com/education/k12/edu_prod A complete directory of curriculum and administrative solutions. 



Microsoft Communications Tools for Schools: http://www.microsoft.com/education/k12/cts/default.htm A collection of communications and Internet tools designed specifically for K-12 education and free* with the purchase of Windows NT Server 4.0. *Shipping and handling charges apply. 



Microsoft Internet Explorer 3.0 for Windows® 95 and Windows NT® 4.0 operating systems: http://www.microsoft.com/ie/ie3/ A powerful browser that supports the latest HTML features, is easy to use, customizable, available for both the Windows and Macintosh platforms, and free from the Microsoft Internet Explorer Web site at microsoft.com. 



Microsoft Internet Explorer 3.0 for the Macintosh: http://www.microsoft.com/ie/mac/ Built for the Macintosh from the ground up, Microsoft Internet Explorer 3.0 for the Macintosh is now available. 



Microsoft Internet Explorer 3.1 for Windows 3.1 and Windows NT 5.1: http://www.microsoft.com/ie/launch/win31.htm A fast, a high-performance browser designed to put you a step ahead on the Internet. 



Microsoft Works: (http://www.microsoft.com/works/)Works includes a word processor for writing letters and memos, a database for keeping track of lists, a spreadsheet for doing budgets and calculations, and communication tools for dialing up other computers or online services.



Scholastic’s The Magic School Bus™ Explores in the Age of Dinosaurs: http://www.microsoft.com/kids/msbdinos.htm Ms. Frizzle and her class take you on another interactive field trip aboard the Magic School Bus. Travel to 7 different dino hot spots in 3 prehistoric eras. 



Scholastic’s The Magic School Bus Explores Inside the Earth: http://www.microsoft.com/kids/msbearth.htm Ms. Frizzle and her class are here to take you on an incredible adventure inside the earth. 



Picture It ™: http://www.microsoft.com/pictureit/ Create, enhance, and share your photographic quality memories(from everyday snapshots to special occasion prints. 



Nickelodeon 3D Movie Maker: Nickelodeon 3D Movie Maker: http://www.microsoft.com/kids/nick3d.htm gives you the power to easily create your own original 3D animated movies. 



P.J.’s Reading Adventures: http://www.microsoft.com/education/products/prod37.htm Three timeless tales unfold into captivating storytelling adventures. 



Microsoft Encarta World Atlas 97: http://encarta.msn.com/atlas/ Delivers the highest quality maps and some of the richest cultural information of any world atlas ever created. 



Microsoft Bookshelf® 1996-97: http://www.microsoft.com/bookshelf/ Provides quick and easy access to a world of useful and interesting information. Offers one-click access to nine best-selling reference works while using any software program on the Windows or Macintosh platform. 



Special Licensing Offer



Microsoft® Open License for Education can provide you with the pricing you need to bring the vision of the Connected Learning Community to life. And now, it can also provide you with free Office 97 and Encarta 97 licenses!



As part of our long-standing commitment to education, we offer specially reduced volume prices for schools with as few as ten desktops. By providing you with licenses, as opposed to packaged products, we can offer you prices up to 70% less than what you would normally pay. For example, Microsoft Office 97 Professional academic edition is $199 US or $279 Canadian for the full-packaged product. An open license for Office 97 Professional is just $52 US* or $71 Canadian(that’s a savings of more than 70%! 



The Microsoft Open License for Education is designed to reduce the costs associated with acquiring, upgrading, maintaining, and managing software by providing simple and flexible volume-based pricing over a two-year period. You simply acquire the minimum number of units at one of two price levels, and continue to receive that discount level for reorders over the next two years. For more information on pricing, visit our Web site at http://www.microsoft.com/education/promos/molp.htm.

The Microsoft Open License for Education offers the full benefits of an innovative volume-based licensing program, including: 

Value. Consistent volume licensing helps you manage overall costs, facilitate consistency school-wide, and maintain control of licensed use of the Microsoft software products you need to operate your academic institution.

Simplicity. The Microsoft Open License volume licensing agreement is easy to understand, communicate, and administer. It features simple, clear terms for acquiring your software licenses. 

Tailored to meet your needs. Customer input helped design this simplified licensing model, which enables you to cover the products you need and offers purchasing levels that best fit your organization. 





Enroll in Microsoft Open License, and receive Microsoft Office 97 and Encarta® Deluxe 97 licenses free.

For a limited time, when you enroll or reorder at least 20 application licenses from Microsoft Open License, you will receive Office 97 and Encarta 97 licenses free. Order 20 application licenses from popular titles like Microsoft Office, Microsoft FrontPage( Web authoring tool, Microsoft Works, Encarta World Atlas, Microsoft Visual J++(, Scholastic’s Magic School Bus(, and more and receive one free Office and one free Encarta license. Order at least 40 application licenses, you’ll receive two licenses for Office 97 and two for Encarta 97(FREE! Order 60 and receive three each, and so on. 

For more information on Microsoft Open License, or the Open License Promotion for Education, contact your Authorized Education Reseller or Microsoft Solution Provider. Call 800-426-9400 in the United States or 800-563-9048 in Canada for the name of a reseller or Solution Provider in your area. Or, visit our World Wide Web site at http://www.microsoft.com/education/pricing/howtobuy.htm. Customers who are deaf or hard of hearing can reach Microsoft text telephone (TT/TDD) services at 800-892-5234 in the United States or 905-568-9641 in Canada.

* Promotion good from March 3 to July 31, 1997 in U.S. and Canada. Offer available to qualifying educational institutions only (call your Microsoft Authorized Education Reseller to see if you qualify). Free Office 97 and Encarta 97 licenses are for Windows( 95 versions of the product only. Your institution must have one legally obtained copy of Office 97 and Encarta 97 for Windows 95 to use the licenses. The free licenses will not count towards a higher Open License purchasing level. Price for Microsoft Office Professional 97 Open license example is quoted at the academic price for the “B” level and is estimated retail value only. Prices may vary.

�Education Solutions Briefings

If you’d like to make smarter technology decisions, take a seat!



The Microsoft Education Solutions Briefing is a FREE 3 hour seminar that introduces K-12 Technology decision makers to Microsoft’s Connected Learning Community Vision and showcases complete technology solutions for school districts of all sizes.



By highlighting actual schools, this seminar shows how your school can also realize the benefits of an enriched learning environment made possible by Microsoft’s networking products, productivity applications, new and exciting Internet applications, and electronic mail.  A combination of presentations, demonstrations, and video testimonial makes this seminar a very informative and useful briefing that will help you start planning immediately. 



By attending this seminar you will walk away with free Internet software and an opportunity to receive a special free product by Microsoft called Communications Tools for Schools, a collection of communications and Internet tools. This product is the only communications solution to incorporate the K-12 Web template, education-specific wizards, e-mail, video-conferencing software, and Internet publishing. In addition, Communications Tools for Schools includes new Macintosh-installable File System drivers, thus extending the cross-platform capabilities of the Windows NT network operating system by providing full network access to native Macintosh CD-ROMs.



This seminar offers suggestions on how your school can get the most out of technology dollars by utilizing Microsoft’s volume licensing alternatives.  In addition, this seminar also offers schools the opportunity for a free, no risk, comprehensive evaluation of all Microsoft products.



You won’t want to miss this exciting opportunity to see how Microsoft products can work in your school. To register for one of these events online go to http://www.microsoft.com/events/ and search on Education Solutions Briefings.  You will see a listing of where and when an Education Solutions Briefing is in your town.  You can also call (800) 550-4300 or e-mail edusem@microsoft.com.



Visit Encarta Schoolhouse—Where the Doors to Learning are Always Open!



Encarta® Schoolhouse at http://www.encarta.msn.com/schoolhouse/default.asp is a free online extension to Encarta Encyclopedia. It provides learners of all ages with opportunities to explore information, ask questions, and participate in challenging activities. Geared primarily to secondary school teachers and students, Schoolhouse is an excellent resource for student reports and an asset for teachers seeking new lesson plan ideas. 



Compelling Content Complements School Curricula…

Encarta Schoolhouse highlights a variety of topics relevant to subjects taught in American schools. Each month the site features a timely curricular topic, such as the February 1997 Harlem Renaissance (http://www.encarta.msn.com/schoolhouse/harlem/harlem.asp) in celebration of Black History Month, or the March 1997 Women in Science topic  (the following URL will not be active until the week of 3/3: http://www.encarta.msn.com/schoolhouse/womensci/womensci.asp) in recognition of Women’s History Month. Previous archived topics include:



Native Americans at http://www.encarta.msn.com/schoolhouse/nativeam/nativeam.asp

Life in the Ocean at http://www.encarta.msn.com/schoolhouse/oceans/oceans.asp

The Olympic Games at http://www.encarta.msn.com/schoolhouse/olympics/olympics.asp

The American Civil War, at http://www.encarta.msn.com/schoolhouse/civilwar/civilwar.asp

The Environment at http://www.encarta.msn.com/schoolhouse/environ/environ.asp 

Earthquakes.<http://www.encarta.msn.com/schoolhouse/equake/shearth.asp





With each topic package, you will find engaging articles and media, relevant Internet links, and related learning activities. In addition, you will have the unique opportunity to have your questions about the current topic answered by an expert in the field—just go to the Ask an Expert page at http://www.encarta.msn.com/schoolhouse/harlem/hrexpert.asp to meet the current expert. 



The Topic Archive at http://www.encarta.msn.com/schoolhouse/tarchive.asp is an easy way to browse the complete Schoolhouse topic packages. If you are interested in exploring certain features, such as Learning Activities, the Topic Archive has quick links to other archives, including the Activity Archive at http://www.encarta.msn.com/schoolhouse/larchive.asp, the Expert Archive at http://www.encarta.msn.com/schoolhouse/xarchive.asp, and the Web Links Archive at http://www.encarta.msn.com/schoolhouse/warchive.asp.



The site also encourages visitors to suggest future Schoolhouse topics by submitting an e-form available on the Upcoming Topics<http://www.microsoft.com/encarta/encwire/upcoming.asp> page.



Features Encourage Students to Become Active Learners…

Topics come alive in Encarta Schoolhouse as just the right amount of multimedia is coupled with fast download speeds for use in schools. Pictures and sounds make information fun and illustrate concepts beyond print, while InterActivities challenge students and adults to learn by doing. The Native Americans InterActivity at http://www.encarta.msn.com/schoolhouse/nativeam/naia.asp provides an exciting way to learn how to count in three Native American languages by listening and responding to audio recordings stored in a Shockwave file. Schoolhouse also encourages students to learn by talking with experts in the field. The Ask an Expert feature teaches students the value of asking questions, and gives schools access to a renowned subject expert every time a new topic is posted. See the Expert Archive at http://www.encarta.msn.com/schoolhouse/xarchive.asp to browse the complete collection of questions and answers addressed by the Schoolhouse experts. 



Discover Fresh Lesson Ideas in Learning Activities…

With every new topic, Encarta Schoolhouse presents an engaging learning activity that can be adapted to middle and high school classrooms. Each learning activity includes clear objectives, step-by-step instructions, and ready-to-use worksheets. The Learning Activity Archive at http://www.encarta.msn.com/schoolhouse/larchive.asp organizes all of the Schoolhouse activities across a broad range of topic areas. For example, students can track their trash in an environmental activity called Where Does all the Garbage Go? at http://encarta.msn.com/schoolhouse/environ/envact1.asp or consider the difficult ethics involved in issues of censorship and free speech in Talk of the Times: Debating the Limits of Free Speech at http://encarta.msn.com/schoolhouse/otractiv/shenact.asp.



Network With Colleagues in the Teacher’s Lounge…

Created just for educators, the Teacher’s Lounge at http://www.encarta.msn.com/schoolhouse/lounge/default.asp is a convenient place for teachers to link to useful educational sites, to communicate with colleagues, and to learn about Microsoft’s special offers to the educational community. Teacher Bulletins at http://encarta.msn.com/schoolhouse/lounge/tbmain.asp is a free service that allows teachers to share information, ideas, and requests with each other. It is an electronic version of a cork bulletin board you might find hanging in a faculty lounge covered with announcements, but this bulletin board reaches teachers all over the world. The Bulletins include a range of requests, such as this one from a fifth-grade teacher: “I’m interested in making teacher/class contacts with people living along the Oregon Trail. My students will be studying this later during the year and it would add interest to talk with those who now live near these historical sites.” And a seventh-grade science teacher writes: “Looking for ideas on an integrated approach to oceanography. Incorporating lessons on: classification, evolution, comparative anatomy, weather, ecology, etc.” Like the classified ads in a Sunday newspaper, Teacher Bulletins are driven by individual contributions and offers something for everyone.



Learn About Special Offers for Educators…

The Teacher’s Lounge is also the place to find out about Microsoft’s Special Offers at http://encarta.msn.com/schoolhouse/lounge/offers.asp for educators. You can learn about Encarta 97 Deluxe School Edition, at http://encarta.msn.com/schoolhouse/lounge/facts.asp, connect to an online Encarta Teacher’s Activity Guide, and find out how to run Encarta over a school network. Encarta Encyclopedia is currently running a special Buy 2, Get 1 Free at http://encarta.msn.com/ms/school/offer.asp offer for educators.



For a limited time, educators can order two copies of the North American edition of Encarta 97 Encyclopedia Deluxe School Edition at $69.95 per copy (plus shipping and handling) before June 30, 1997, and get a third copy free. To learn more about this offer and to order copies online, go to the Buy 2, Get 1 Free page, or call 1-800-615-8149.
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